Guide to Electronic Grade Submission

Office of Information Technology; Office of Student Records and Registration

February 12, 2008

All grades will be submitted electronically beginning in Spring 2008. This document contains detailed instructions that will guide you through the process, even if you have never used WebCT or Blackboard. (Blackboard CE, referred to as Blackboard from now on, is the course management tool formerly known as WebCT version 6, sometimes called the “new” WebCT.)

Most departments have appointed a Grade Facilitator who has been trained in the process. Contact your Department Chair to learn the identity of your Grade Facilitator.

If you need help with grade submission, contact your Grade Facilitator, or contact the help team by phone (during business hours) or e-mail: 487-1111 or courses@mtu.edu.

Three sets of instructions are included in this guide:

- Experienced instructors who are comfortable with Blackboard and interactive web-based applications may follow the concise, one-page instructions on Page 2.

- Instructors who are less familiar with Blackboard or interactive web-based applications may follow the detailed, step-by-step instructions on Pages 3-10.

- Tips for working with Blackboard, including spreadsheet support, are included on Pages 11-12.

The detailed instructions on Pages 3-10 include many screen captures and tips for avoiding common problems. Please review these materials prior to starting the grade submission process.

The grade submission process consists of two basic steps:

1. Enter grades into the Blackboard Grade Book for each course.

2. Use the web-based “Grade Wizard” to transfer grades from Blackboard to Banner.

Note: For the time being, the manual grade change card/signature process is still being used for changes after grades have been submitted electronically. Any grades that must be submitted after the grade submission deadline must also be submitted manually.
Concise Instructions for Experienced Users

Instructors who are familiar with Blackboard and who have participated in the electronic grade submission trials, or who are very comfortable with interactive web-based processes, may follow the steps listed on this page.

1. Enter your grades into the Blackboard Grade Book
   - Log on to Blackboard at courses.mtu.edu with your ISO userid and password.
   - For each course, click on the course link in your Course List on the “My Blackboard” page. Click the “Teach” tab, and enter the Grade Book by clicking the Grade Book button on the left navigation bar (towards the bottom, under “Instructor Tools”).

   The only valid Mid-Term grades are SA (satisfactory) and UN (Unsatisfactory)

   • Enter grades for each student in the Blackboard Grade Books. Make sure grade changes are saved. Entering Mid-Term grades in the column labeled “Mid-Term” and entering the Final grades in the column labeled “Final” will be the safest choice. However, you may choose to create your own columns and column names, and you will have the opportunity to extract grades from these columns in the Grade Wizard.

2. Use the web-based Grade Wizard to transfer grades from Blackboard to Banner
   - Launch the Grade Wizard. This can be done one of two ways:
     - Click the “Submit Grades to Banner” link in the “Campus Announcements” section of your “My Blackboard” homepage; or
     - Visit the coursetools.mtu.edu website and choose electronic grade submission.
   - Follow the multiple-step process by which the Grade Wizard extracts grades from your Blackboard Grade Books and transmits them to Banner. This must be done for each course assigned to you. When the Grade Wizard completes the grade transfer for a course, it will produce a confirmation page listing the students and grades that were submitted to Banner. You may print (use control-p) or save the confirmation page. **The process is not complete for a course until you have received a web page that lists “Grade – Uploaded to Banner” in the “Final Result” column for each student.**

**Important:** If you built a Blackboard course by importing an old Blackboard or WebCT course from Fall 2007 or earlier, the Grade Book column for the Mid-Term grade is likely to be labeled “Midterm” instead of “Mid-Term”. This may cause problems for the Grade Wizard; you **may** need to change the Mid-Term grade column in the Grade Wizard (Page 8.).

If you combined sections manually, you **may** need to create both the “Mid-Term” and “Final” grade columns. Be sure to choose “Alphanumeric” for the column type.

If you experience problems or database errors, consult the detailed instructions on Pages 3-10. Contact the help team by phone or e-mail if necessary afterwards.
Detailed Instructions

Blackboard help is available on the web at coursetools.mtu.edu, by phone at 487-1111 during business hours, by e-mail at courses@mtu.edu, or in person during posted office hours or by appointment. General Blackboard tips are listed on Pages 11-12. In the interest of brevity, this section of the Guide only covers those aspects of Blackboard that are directly related to grade submission.

Blackboard now communicates regularly with Banner. The Grade Books in your Blackboard courses are updated hourly for adds, and nightly for drops. By either exporting the Blackboard Grade Book to a spreadsheet, or by using the Blackboard Grade Book for your record keeping, you eliminate the need to type rosters. Further, the Grade Book rosters are always current and accurate.

Step 1 – Enter grades into your Blackboard Grade Books

Log on to Blackboard at courses.mtu.edu. You will be prompted for your user name and password. Use the same name and password as you do for Huskymail. If you are not able to log on, contact your System Administrator for help with your ISO password and user name. If you are able to log on, you should see your “My Blackboard” home page, which should resemble the image below.

The courses for which you are an instructor should appear in the center box entitled “Course List”. If courses are missing, contact the help team by e-mail or phone. See the tip on Page 11 for managing this Course List, related to the circled “pencil” icon above.
Click on any course in the Course List to enter the course. Then, in the upper-left hand corner, you will see three tabs: Build, Teach, and Student View (circled at right.) The “Build” tab is where you add content. “Student View” allows you to see what the students will see. The “Teach” tab is where you interact with the students. The Grade Book is only visible in the “Teach” tab. Click the “Teach” tab to access these tools.

After clicking the “Teach” tab, you should see the Grade Book button on the left-hand side, towards the bottom, under Instructor Tools (arrowed.) Click the Grade Book button to access the Grade Book.

**Note:** To maximize space in the main window, Blackboard minimizes the width of the left navigation bar when you click the Grade Book or other features. To recover the full width, click this icon:
A typical Grade Book is shown below. There should be pre-assigned columns for the Mid-Term and Final grades. If these columns are not present, for example if you combined different sections, create them with the “Create Column” button in the upper-left hand corner, and choose a column of the type “Alphanumeric.” Note that column names are case-sensitive; the Grade Wizard will recognize “Final” and “FINAL” as two different columns. Note that courses built by importing Fall 2007 or earlier courses are likely to have a column named “Midterm” instead of “Mid-Term”, which may or may not result in missing grades during the Grade Wizard process; to fix this, either add a new Alphanumeric column called “Mid-Term” in the Grade Book, or change the selected grade column when you run the Grade Wizard (Page 8.)

![Grade Book Image]

**Important:** By default, the Blackboard Grade Book only displays 20 students at a time. This resulted in confusion and missing grades during grade submission trials. To fix this, click the page icon at the bottom-right hand corner of the Grade Book page (circled above.) This will launch a pop-up window that allows you to set the number of students displayed up to 999. Once you save this, Blackboard will remember it. However, you need to do this for every course once, as there is currently no way to change this default globally. If you prefer seeing only 20 students at a time, you can page through them by changing the page number and clicking the green “go” arrow (both to the left of the red circle above).

There are two ways to enter or change grade entries. To rapidly enter a list of grades, click the icon directly to the left of the column name (circled below,) and choose “Edit Values” from the pop-up box that appears after you click the icon.
A list of students will appear. If a grade is already entered, it will be listed in the “Current Value” column. Otherwise, it will be blank. In either case, there will be an empty box for each student in the “Change to” column. Move the cursor into the first box (circled below,) left-click, and enter the new grade. If you “tab,” the cursor will move to the “Change to” grade box for the next student.

A second way to enter or change grades is to click on the dashed line (in a blank grade cell) or on an existing grade (in an occupied grade cell.) This will generate a pop-up box that allows you to review the current grade and enter a new one, student-by-student. This works well for individual grade changes and for entering grades in small sections, but it is painfully slow for large classes.

After saving the grades, you have completed the Blackboard portion of grade submission. You can enter grades for other courses if you wish, then go on to the Grade Wizard.

**Step 2 – Use the Grade Wizard to transfer grades from the Blackboard Grade Books to Banner**

The Grade Wizard can be used to transfer grades for all your courses at the same time, or to transfer grades for one course at a time in different sessions.

Launch the Grade Wizard. This can be done one of two ways.

- Click the “Submit Grades to Banner” link in the “Campus Announcements” section of your “My Blackboard” homepage; or
- Visit the coursetools.mtu.edu website and choose “Submit Grades Electronically.”
In either case, you will be directed to the coursetools.mtu.edu home page, which should resemble the page below.

Clicking the “Submit Grades Electronically” link (circled above) will launch a page similar to the one below.

Proceed to the next step by clicking one of the “Launch Grade Wizard” buttons, near the bottom of the page (circled above,) for either the Mid-Term or Final grade submission period.
The example discussed in the remainder of this document was generated by the “Launch Grade Wizard (Final)” button, but the procedures for the Mid-Term submission are identical. Clicking the button should launch a web page with a listing of all the courses assigned to you that require grade submission, similar to the page below. During the Mid-Term process, only courses containing first-year students will appear.

The two columns on the left are self-explanatory. If you combined Blackboard sections, grades will automatically be retrieved from the correct “combined section,” as in the example above. As explained on the top of Page 5, if you combined sections manually, you may need to add Grade Book columns to the Combined Blackboard section Grade Book.

The third column in the table above lists the columns in your Blackboard Grade Books from which the grades will be extracted. The Grade Wizard will need to be informed if you placed Mid-Term or Final grades in a Grade Book column other than the one listed in Column 3 above; change the Grade Book column by following the self-explanatory instructions that appear when you click the “Change Blackboard Grade Book Column” button in the fourth column.

Important: If you “copied” or “exported” courses from Fall 2007 or earlier to build your course, the Grade Book is likely to contain “Midterm” instead of “Mid-Term”. This may result in missing grades during the Grade Wizard process. If so, click the “Change Blackboard Grade Book Column” button, and select the column that contains the grades.

If everything appears to be correct, click the “Continue with Grade Process” button at the bottom of the page (circled above.) This will initiate a database transfer from Blackboard to your browser. Grades for all your courses will be retrieved. This process may take a few minutes, especially if you have a large number of students, or if many people are using the system. Please be patient; do not quit the browser, and do not click “back” or “refresh”.
After the database transfer process is complete, you should receive a new web page containing a table that summarizes your results, similar to the one shown below.

<table>
<thead>
<tr>
<th>Course</th>
<th>Students with valid grades</th>
<th>Students with invalid grades</th>
<th>Students with missing grades</th>
<th>Upload Grades</th>
</tr>
</thead>
<tbody>
<tr>
<td>MY 3400 (10380)</td>
<td>12</td>
<td>Review 1 Invalid Grades</td>
<td>0</td>
<td>Review Invalid Grades</td>
</tr>
<tr>
<td>MY 3400 (13892)</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Transfer Grades to BANNER</td>
</tr>
<tr>
<td>MY 3400 (13891)</td>
<td>12</td>
<td>0</td>
<td>Review 1 Missing Grades</td>
<td>Transfer Grades to BANNER</td>
</tr>
</tbody>
</table>

The table above shows all the possible outcomes of the database transfer. For each course, you may see valid grades, invalid grades, or missing grades. If you have no missing or invalid grades, click the “Transfer Grades to Banner” button for one of your courses in “Upload Grades” column above, then skip to the second paragraph of Page 10.

**Important:** During the trial period in Fall 2007, some instructors received a database error when clicking the “Continue with Grade Process” button. We believe that we have fixed this, but if it happens to you, please try the following. Return to the page similar to the screen capture on the top of Page 8 and click the “Continue with Grade Process” button again. If this doesn’t work, click the “Change Blackboard Grade Book Column” boxes for your courses, choose the proper column (even if it is not changing), save the changes, and click the “Continue with Grade Process” button again. If this still does not work, contact the help team by e-mail or phone. If any of these problems occur, please e-mail courses@mtu.edu and tell us what happened so we can de-bug this tool for future semesters.

If you have invalid or missing grades, you need to go back to your Blackboard Grade Books and fix the problems. Note that the Grade Wizard will allow you to submit missing grades (the student will receive an “M,”) but it will not allow you to submit invalid grades.

**Invalid Grades:** Click the “Review N Invalid Grades” button in the table. A new window will appear that lists the students and their invalid grades. It is possible that you entered a grade code that does not exist (T, for example.) It is also possible that you entered a forbidden grade (an “A” in a pass/fail class, for example.) Click the “View Valid Banner Grades” link on the page to review valid grades. SA and UN are the only valid Mid-Term grades.

**Missing Grades:** Click on the “Review N Missing Grades” button. A new browser window will appear that lists the students with missing grades. If you do not intend to assign M grades, the cause of the missing grades must be discovered and fixed before you submit any grades to Banner. The most common reasons for missing grades are the existence of blank cells in the Blackboard Grade Book Mid-Term or Final column, and a mismatch between the column names containing your grades and the column name chosen in the Grade Wizard. (For missing Mid-Term grades, also recall the yellow box on Page 8 as a possible source of error.) If there are more than 20 students in the course, you must be aware that the Blackboard Grade Book only displays 20 students at a time by default. This has led to missing grades for the students beyond 20 in grade submission trials. See Page 5 to fix this problem.
If you have invalid or missing grades, please fix the Grade Book entries or choose the correct Grade Book column in the Grade Wizard to fix the problems. Then click the buttons to “Retrieve Updated Blackboard Grades” for each section that had a problem, or re-run the Grade Wizard. After fixing and retrieving missing or invalid grades, you should get a new page with a table similar to the one on the previous page, but with only valid grades listed. The buttons in the “Upload Grades” column (far right) should all say “Transfer Grades to Banner.” Contact the help team by phone or e-mail if this is not the case.

After invalid/missing grade issues are fixed, click the “Transfer Grades to Banner” button in the right-hand column for one of your courses. A new browser window will appear which asks you to review and confirm the grades, similar to the following:

![Confirm Final Grades](image)

Click the “Yes” button to authorize submission, then click the “Submit Grades to Banner” gray button at the bottom. A confirmation page similar to the following will appear. You are now finished with the first course, but most of the work is already done for the rest of your courses (assuming the grades are in the Blackboard Grade Books).

![Blackboard Final Grades](image)

**Important**: Control-p will allow you to print the confirmation page to your default printer, or you can save the page with File → Save As. You can also review grades that were submitted by clicking the “Return to Processing Grades” button or by running the Grade Wizard again.

Click the “Return to Processing Grades” button to complete your other courses, or quit and use the Grade Wizard later. After grades have been submitted to Banner, any changes that may become necessary must be made manually at the Office of Student Records and Registration.
Selected Blackboard Tips

The web pages at coursetools.mtu.edu and blackboard.mtu.edu contain many helpful documents, including office hours for in-person Blackboard support.

Blackboard and grade submission training for groups or departments is available by request. Please call 487-1111 or e-mail courses@mtu.edu.

The default security settings in Internet Explorer prevent you from downloading files from Blackboard to your computer. This is a Microsoft security feature intended to prevent malicious files from being downloaded while browsing. This is even true for files that you uploaded. To fix this, access the IE security settings under Tools → Internet Options → Security (on the top menu bar.) Click “Trusted Sites” and add https://courses.mtu.edu to your “Trusted Sites.” Do not forget the “s” in https (indicating an encrypted, secure website.)

If you are teaching cross-listed courses or multiple sections of the same course, note that we have developed a simple, web-based tool to combine your courses into one Blackboard section. This tool will be ready for Fall 2008, and will be available on the coursetools.mtu.edu page.

If you click the “pencil” icon on the top right of the course list box (circled on Page 3,) you will be able to hide or show any courses assigned to you. This can reduce clutter in your home page without deleting important content.

Instructors who build their own class web pages are encouraged to experiment with Blackboard. The students grow accustomed to it in their Physics, Chemistry and Math courses, and they actually like it. They only need to visit one website for all their classes. Further, since it is authenticated, only students in your class can access the content.

Instructors who use spreadsheets are encouraged to experiment with the Grade Book. There are built-in tools to construct grade histograms and statistics. Students prefer this mechanism because they can receive immediate feedback on performance (and class grade distributions) if the instructors choose to release grades and grade statistics to the students.

In the interest of presenting faculty with a Grade Book that is consistent with the Banner roster, students who withdraw from your courses are “unenrolled” and removed from the Grade Book that evening. If you wish to see Grade Book data that was entered prior to withdrawal, click the “Grade Book Options” box in the upper-right hand corner of the Grade Book, and select “Show Unenrolled Member Data” in the pop-up box that appears.

Your students can change a setting in their Blackboard Profile that will result in automatic forwarding of Blackboard e-mail to their mtu.edu e-mail address. This eliminates the need for class e-mail lists. You can send bulk e-mail to your classes easily in Blackboard. See blackboard.mtu.edu for instructions.

A shortcoming of this version of Blackboard is that there is no convenient way to print your Grade Book. The easiest way to print it is to export it to a spreadsheet, open it in Excel or equivalent, then print from the spreadsheet. See the next page for spreadsheet support.
Spreadsheet Support

Some instructors prefer to use Excel or another spreadsheet during the semester, instead of using the Blackboard Grade Book. It is possible to do this fairly easily, while still taking advantage of the Banner rosters and the Grade Wizard. Further, exporting to a spreadsheet is the best way to make a hard-copy printout of your Grade Book.

After the rosters have come to some equilibrium, perhaps a day or two after the final “add” day of the semester, you can export your Grade Book to a spreadsheet. Click the “Export to Spreadsheet” box, circled below. Choose “comma delimited” for the file type when prompted on the screen that pops up when you click the “Export to Spreadsheet” button. The Grade Book will be exported to a file called exportedcourse.csv, which should end up on your desktop or in your “downloads” folder. Use the Windows Search utility if you cannot easily find its location.

Important: Blackboard does not export or import directly to/from Excel. It uses a standard format called .csv (comma separated values), which is a text-only file that Excel or any other spreadsheet will open and convert to spreadsheet format (.xls, for example).

In order to make a spreadsheet importable by Blackboard, the spreadsheet must be saved in .csv format. (Choose “Save As” and change the file type to .csv.) Most instructors who choose to use spreadsheets should save as .xls and .csv, but the .csv is only necessary when the import to Blackboard will be accomplished (at grade submission time, for example.) Note that saving in .csv will only save one worksheet at a time, and not the entire workbook. Furthermore, graphics, equations and calculations will not be retained in the .csv version.

For detailed spreadsheet instructions, visit coursetools.mtu.edu

You can do anything you want with the spreadsheet, and then import it back to the Grade Book later. Use the “Import from Spreadsheet” button, circled above. There is some column-matching that needs to occur on import, as described at coursetools.mtu.edu.